The Title Goes Here with Each Initial Letter Capitalized
(Use the Microsoft Word template style: Paper Title)

Author’s Name! ® and Author’s Name?* 3
(Use the Microsoft Word template style: Paper Author)

(Use the Microsoft Word template style: Author Affiliation) Replace this text with an author’s affiliation
(use complete addresses). Note the use of superscript “a)” to indicate the author’s e-mail address below.
Use b), ¢), etc. to indicate e-mail addresses for more than 1 author.
2Additional affiliations should be indicated by
superscript numbers 2, 3, etc. as shown above.
3You would list an author’s second affiliation here.

3Corresponding author: your@emailaddress.xxx
Yanotherauthor@thisaddress.yyy
(Use the Microsoft Word template style: Author Email)

Abstract. The AIP Proceedings article template has many predefined paragraph styles for you to use/apply as you write
your paper. To format your abstract, use the Microsoft Word template style: Abstract. Each paper must include an
abstract. Begin the abstract with the word “Abstract” followed by a period in bold font, and then continue with a normal
9 point font.

FIRST, SECOND, AND THIRD LEVEL HEADINGS (FIRST LEVEL HEADING)
(Use the Microsoft Word template style: Heading 1)

This document was prepared using the AIP Proceedings template for Microsoft Word. It provides a simple
example of a paper and offers guidelines for preparing your article. Here we introduce the paragraph styles for Level

1, Level 2, and Level 3 headings. Please note the following:

e In this template we note whether each heading is Level 1, 2, or 3 — for example, “(Second Level Heading).”

This is for guidance only; your article headings will, of course, not need those notations.

e  Under each heading we have noted which paragraph style to use — for example, “(Use the Microsoft Word
template style: Heading 2).” Again, those notes are not part of the headings. Their purpose is to advise you

of the name of the style defined in the AIP Proceedings Word template.

To format a paragraph, use the Microsoft Word template style: Paragraph.

Do not include any headers, footers, or page numbers in your document. They will be added to your article

PDF by AIP Publishing, so please do not amend this template to add them to your paper.

How to Apply the AIP Proceedings Template Paragraph Styles (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

Here is how to display a pop-up window from which to select and apply the AIP Proceedings template paragraph

styles:



-
x

@ Click here to display the Sw:;,m

A Styles window — making it easy bt T
A to choose and apply the AIP !
- Change Proceedings template styles. [ N
* | Styles To apply a style to a . - v
Editing paragraph, click anywhere in the P v
. Figure Caption T
paragraph text then click on the . .
appropriate style listed in the Heading 2 v
Styles window. Haadng 3 v
Hyperlink a
‘Normal T
Paper Author L4
Paper Title T
Eam—
@ ® & Optins

How to Use this Template (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

You can edit or delete the content provided in this template and replace it with the text and figures of your
article. Please be sure you do not accidentally leave any of this text as part of your paper!

Heading with Each Initial Letter Capitalized (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

Apart from prepositions and articles, all words in second and third level headings should have their initial letters
in uppercase. Prepositions are words like “for,” “from,” “with,” “in,” “off,” and articles include words such as “an,”
‘$a’,’ “the_”

This is the paragraph spacing that occurs when you use the [ENTER] key.

Heading with Each Initial Letter Capitalized (Third Level Heading)
(Use the Microsoft Word template style: Heading 3)

As with first and second level headings, all words except prepositions and articles (see above) should appear
with initial letters in uppercase.
This is the paragraph spacing that occurs when you use the [ENTER] key.

MATHEMATICS (FIRST LEVEL HEADING)
(Use the Microsoft Word template style: Heading 1)

Here we provide some basic advice for formatting your mathematics, but we do not attempt to define detailed
styles or specifications for mathematical typesetting. You should use the standard styles, symbols, and conventions
for the field/discipline you are writing about.

A Note on Microsoft Word’s Equation Editors (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

From Word 2007 onwards, Microsoft Word provides two “Equation Editors,” which, for ease of reference, we’ll
call “Old Style Equations” and “New Style Equations.”

e “New Style Equations” (Word 2007 onwards): With Word 2007 Microsoft introduced a powerful new
built-in Equation Editor that enables input of sophisticated mathematics typeset (usually) in the Cambria
Math font. You access it from the Insert menu.



e “Old Style Equations” (Word 97-Word 2003): For versions of Microsoft Word between Word 97 and
Word 2003, mathematical input was created by an add-in: Inserting and editing a “Microsoft Equation 3.0
object,” typically by Insert = Object and selecting “Microsoft Equation 3.0.”

Newer versions of Microsoft Word (Word 2007 and onwards) still support the original “Old Style Equations”
method of creating mathematics by inserting an equation via Insert = Object and selecting “Microsoft Equation
3.0.7

Which Microsoft Word Equation Editor Should I Use? (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

Due to technical requirements of OpenType font technology, Microsoft Word’s “New Style” Equation Editor
works only with fonts specially designed for mathematical typesetting. Unless you have obtained and configured
new OpenType math fonts, it is highly likely that your installation of Word will use the Cambria Math font for all
mathematics created with the “New Style” editor. Using the Cambria Math font for mathematics and Times Roman
for your text will cause a mismatch in the visual appearance of your article, so, for consistency, we prefer authors to
use the “Old Style” Equation Editor because it is straightforward to amend the size/style of the fonts it uses.

Formatting and Inserting Equations (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

Equations should be centered with equation numbers on the right-hand side (flush right). Achieving a pleasing
layout of equations can be tricky in Microsoft Word, so here are some tips. You can either:

1. Copy, paste, and edit the sample equation provided (recommended), or

2. Manually insert an equation and equation number

Copy, Paste, and Edit a Sample Equation (Third Level Heading)
(Use the Microsoft Word template style: Heading 3)

To use this “Old Style Equation” as a “template,” highlight the entire line, then use cut and paste to the new
location. Note that the equation number will automatically update (increment).

M=SAm2 cos @, MzSAm2 cosw (1)
dw, d

Manually Inserting an Equation and Equation Number (Third Level Heading)
(Use the Microsoft Word template style: Heading 3)

If you prefer to manually insert and number equations, follow this step-by-step guide:
1. Make sure you can see “hidden characters” by switching on “show invisibles” from the Home menu (it

looks like this: ). This allows you to see paragraph markers () and tab characters (=), which are usually
hidden from view.

2. Create a blank paragraph by pressing [ENTER].

3. Format your new blank paragraph by applying the Microsoft Word template style: Equation. The Equation
paragraph style sets up the tabs so that you can center the equation and have an equation number appear at
the right.

4. Place your cursor at the start of your new paragraph and press the [TAB] key twice.

5. Place your cursor between the tab characters () and insert your equation using Insert = Object = Microsoft
Equation 3.0.

6. To add an equation number, place your cursor at the end of the paragraph (just before the paragraph markers
(1) and after the second tab character (=)).

7.  On the Insert tab, in the Text group, click Quick Parts and then click Field:
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8. A dialog box should appear:

9. From the list of Field Names on the left of the dialog box, select ListNum.
10. From the list of Field properties on the right, select the “Equations” List name and click OK. You should
now see an equation number in parentheses: e.g., (3).

OTHER SPECIFICATIONS (FIRST LEVEL HEADING)
(Use the Microsoft Word template style: Heading 1)

Figures, tables, and equations must be inserted in the text and may not be grouped at the end of the paper.
Important: A miscount of figures, tables, or equations may result from revisions. Please double check the numbering
of these elements before you submit your paper to your proceedings editor.

Figures (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

If you need to arrange a number of figures, a good tip is to place them in a table, which gives you additional
control of the layout. Leave a line space between your figure and any text above it, like this one:

relative miensty (arb, units)

20 40 60 80 100 120 140 160
number of carbon atoms

(a) (b)

FIGURE 1. To format a figure caption use the Microsoft Word template style: Figure Caption. The text “FIGURE 1,” which
labels the caption, should be bold and in upper case. If figures have more than one part, each part should be labeled (a), (b), etc.
Using a table, as in the above example, helps you control the layout

Cite all figures in the text consecutively. The word “Figure” should be spelled out if it is the first word of the
sentence and abbreviated as “Fig.” elsewhere in the text. Place the figures as close as possible to their first mention



in the text at the top or bottom of the page with the figure caption positioned below, all centered. Figures must be
inserted in the text and may not follow the Reference section. Set figure captions in 9 point size, Times Roman font.
Type the word “FIGURE 1.” in bold uppercase, followed by a period.

Color Figures (Third Level Heading)
(Use the Microsoft Word template style: Heading 3)

Authors are welcome to use color figures within their article. For online publication, there are no costs added for
color figures. However, for printed proceedings (if requested by your conference organizer), there is an additional
cost. Please consult directly with your conference organizer. If your conference organizer has asked AIP Publishing
to produce printed copies (many ask AIP Publishing for online-only publication), then all figures will be printed in
black-and-white unless you make specific arrangements with your organizer(s) to include color figures in your
article and pay to them the associated fee(s) they request. We advise that many color figures can be printed in black-
and-white with no loss of information; however, some figures do lose information when reproduced in black-and-
white. Check your figure legends carefully and, if your figures are to be printed in black-and-white, remove from
your text/descriptions any references to color.

Tables (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

Due to the wide range and complexity of tables, we simply offer an example for guidance. Please follow the
style for table (and figure) captions.

TABLE 1. To format a table caption, use the Microsoft Word template style: Table Caption. The text
“TABLE 1,” which labels the caption, should be bold and all letters capitalized. Center this text above the
Table. Tables should have top and bottom rules, and a rule separating the column heads from the rest of the table

only.
Column Header Goes Here Column Header Goes Here Column Header Goes Here
Row Name Here X X
Row Name Here X X
Row Name Here X X

FINAL KEY POINTS TO CONSIDER (FIRST LEVEL HEADING)
(Use the Microsoft Word template style: Heading 1)

Here are the main points you need to follow (the AIP author template packages contain comprehensive
guidance):

e  Write and prepare your article using the AIP template.
e Create a PDF file of your paper (making sure to embed all fonts).
e Send the following items to your conference organizer:
o PDF file of your paper
o Signed Copyright Transfer Agreement
o  (If it applies) Copies of any permissions to re-use copyrighted materials in your article (e.g., figures
from books/journals)

Font Embedding (Second Level Heading)
(Use the Microsoft Word template style: Heading 2)

As the author and creator of your article PDF, you have the most intimate knowledge of exactly what the PDF
should display. We ask all authors to carefully check their article PDF prior to submission. Perform visual
inspections to detect subtle font errors and ensure that all fonts are embedded. With the wide range of tools and
software that authors use to create PDFs, and the number of devices and platforms that readers use to view/print
them, font embedding by authors is not only “nice-to-have”; it is essential.



Why Should I Care About Font Embedding? (Third Level Heading)
(Use the Microsoft Word template style: Heading 3)

Embedding fonts into your PDF file is critically important for two reasons:

1.
2.

Commercial printing companies are unable to print PDFs without the correct fonts embedded.
To ensure that your online article PDF file displays and prints correctly for everyone who wants to read your
work.

Readers of scientific articles use an ever-increasing range of devices and applications to access, view, and print
PDFs — from smart phones and tablets to desktop computers running any one of a number of operating systems. To
ensure that readers of your article can display and print it correctly, it is important for your article’s PDF file to be
truly portable: Your PDF file needs to be fully “self-contained.”

Summary: Points to Consider when Preparing Your Paper
(Use the Microsoft Word template style: Heading 2)

Well prepared papers enable rapid publication and reduce unnecessary work for your proceedings editor(s). The
following points summarize the key issues you need to comply with when preparing your paper for AIP
Proceedings.

Check your article PDF file! It is not uncommon for errors to appear in PDFs generated from Microsoft
Word — corrupted math, figures reflowing, etc. It is absolutely essential to very carefully check your article
PDF file before sending it to the proceedings editor(s).

Do not add page numbers or headers/footers. Our article templates deliberately do not include these, so
please do not add them.

Do not alter the margins of our templates. They are carefully designed for AIP’s production process:
Altering them can cause significant delays.

Prepare and format references with care. Please prepare and format your references in accordance with
the examples supplied with the author templates and documentation.

Embed all fonts into your article PDF. The importance of font embedding is discussed in the section Font
Embedding (above). PDFs supplied without embedded fonts are often completely unusable for printing or
publication purposes. In such cases, we have to return those PDFs to the proceedings editors for font
embedding. Failure to embed fonts can cause unnecessary inconvenience to your proceedings editor(s) and
publication delays for other authors. Failure to provide a replacement paper in a timely fashion may result in
an article being removed from the proceedings.

Use clear, legible graphics and diagrams. Readers of your paper will be grateful. If they cannot read it,
they are unlikely to cite it.

Do not use copyrighted material without permission. Papers using copyrighted material without
appropriate permission and acknowledgment will be excluded from the proceedings.

No 1-page papers please. 1-page, abstract-only contributions are not acceptable and will be excluded from
the proceedings.

Avoid large PDF files (10 MB maximum, ideally). For the benefit of your readers, we recommend keeping
your article PDF file below 10 MB. This is a recommendation, not a requirement.

Where to Find Further Information
(Use the Microsoft Word template style: Heading 2)

We warmly invite you to visit our online platform, Scitation, where you can find further help/advice and
publishing policies for AIP Proceedings:

For authors: http://proceedings.aip.org/authors
For conference organizers: http://proceedings.aip.org/organizers




ACKNOWLEDGMENTS
(Use the Microsoft Word template style: Heading 1)

Ut wisi enim ad minim veniam, quis nostrud exerci eliton ullamcorper suscipit lobortis nisl ut aliquip ex en
commodo consequat. Duis te feugifacilisi per suscipit lobortis nisl ut aliquip ex en commodo consequat.Lorem
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magna aliguam erat volutpat.

The reference section will follow the “Acknowledgment” section. References should be numbered using Arabic
numerals followed by a period (.) as shown below, and should follow the format in the below examples.
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(Use the Microsoft Word template style: Heading 1)
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KEYBOARD SHORTCUTS

The JPCS ICSAS template contains a collection of styles which are applied using the custom toolbars.

The following key combinations can be used to achieve the same result.
e  Paper Title (Alt + Ctrl + T)

Author Name (Alt + Ctrl + N)

Author Affiliation (Alt + Ctrl + A)

Author Email (Alt + Ctrl + E)

Abstract (Alt + Ctrl + S)

Heading 1 (Alt + Ctrl + 1)

Heading 2 (Alt + Ctrl + 2)

Heading 3 (Alt + Ctrl + 3)

Paragraph (Alt + Ctrl + Z)

Normal (Alt + Ctrl + X)

Equation (Alt + Ctrl + G)

Paragraph (bulleted) (Alt + Ctrl + B)

Figure caption (Alt + Ctrl + F)

Table Caption (Alt + Ctrl + H)

Reference (Alt + Ctrl + R)

Reference (no number) (Alt + Ctrl + W)



